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Adrian Kaim — doktorant Szkoty Doktorskiej Politechniki Wroctawskiej i1 cztonek
Laboratorium Badania Potprzewodnikow Metodami Elektrycznymi w Katedrze Fizyki
Doswiadczalnej na Wydziale Podstawowych Probleméw Techniki. W ramach doktoratu
prowadzi badania zwigzane z fotodetektorami opartymi m. in. na efekcie
pirofototronicznym. Jest posiadaczem certyfikatu CLAD
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Plan zajec

1. Wprowadzenie (2h)

4. Dokumentacja i
wizualizacja danych
(2h)

5. Macierze, tablice,
klastry (2h)
Funkcje graficzne (2h)

Struktura event (2h)

8.

2 i 3. Funkcje i struktury (4h) 9.

10.

11.

12.
13.

Obstuga joysticka (2h)
Komunikacja z
komputerem (2h)

Wyswietlacz 7-
segmentowy (2h)

Potencjometr,
przetgcznik DIP (2h)

Silniczek servo (2h)
Wstep do projektu (2h)

14-15. Projekt, zaliczenie (4h)
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Zaliczenie

Na podstawie:

Projektu — ostatnie trzy zajecia + praca poza zajeciami

Aktywnosci

Pracy na zajeciach

Obecnosci
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Kurs podlega zaliczeniu w trakcie semestru. Gtowng sktadowa oceny koncowej jest
ocena z projektu zaliczeniowego przygotowywanego na trzech ostatnich zajeciach (oraz
poza zajeciami). Dodatkowo na ocene koncowa sktadaja sig:

o aktywnos$¢ w trakcie zajec,
. praca na zajeciach (wykonywanie zadan),

. frekwencja.
Warunki konieczne do uzyskania pozytywnej oceny koncowe;j:
o obecnos¢ na przynajmniej 13 z 15 zaje¢ (nie dotyczy sytuacji nadzwyczajnych, w

ktorych nieobecnos$ci zostang usprawiedliwione),

. ztozenie projektu zaliczeniowego, ocenionego pozytywnie przez prowadzacego.
Warunki konieczne do uzyskania celujacej oceny koncowe;:
. obecnos¢ na przynajmniej 13 z 15 zajec¢ (nie dotyczy sytuacji nadzwyczajnych, w

ktorych nieobecnosci zostang usprawiedliwione),

o ztozenie projektu zaliczeniowego, ocenionego bardzo dobrze lub celujgco przez
prowadzacego,

o wykazywanie aktywnoS$ci na zajgciach,



J wykonanie ponad potowy przewidzianych zadan.

Projektem =zaliczeniowym jest program przygotowany w jezyku graficznym G
(LabVIEW). Program oceniany jest pod katem samodzielnos$ci, czytelnosci kodu oraz
interfejsu, udokumentowania kodu, efektywnosci dziatania kodu, zaawansowania struktur
wykorzystanych w  programie oraz obstugi bledow (programistycznych oraz
uzytkownika).



Materiaty

e Dokumentacja LabVIEW = www.ni.com/getting-
started/LabVIEW-basics/online-help

e Wykfady dostepne na stronie prowadzacego

e ,LabVIEW w praktyce” Marcin Chrusciel, Wydawnictwo
BTC, 2008.

e ,Srodowisko LabVIEW™ w eksperymencie wspomaganym
komputerowo” Wiestaw Ttaczata, Wydawnictwo WNT,
2014.
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LabVIEW dla studentow

Opis instalacji oraz klucz licencyjny dostepne na stronie:

di.pwr.edu.pl/oprogramowanie/LabVIEW
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Studenci Politechniki Wroctawskiej maja dostgp do licencjonowanego pakietu
LabVIEW. Wszystkie informacje, pliki instalacyjne oraz klucze licencyjne dostgpne sa
na stronie Dzialu Informatyzac;ji.



https://di.pwr.edu.pl/oprogramowanie/labview

Laboratory Virtual Instrument
Engineering Workbench

LSrodowisko to od poczatku prezentowato odmienne podejicie do
sposobu tworzenia programu. Tworzenie programu polega w nim na
taczeniu roéznych graficznych ikon, z ktérych kazda odpowiada za
wykonywanie rdéznych funkcji. Wykonywanie programu nie jest w tym
przypadku realizowane poprzez wykonywanie poszczegolnych linii kodu,
poniewaz takowe nie wystepuja. (...)
Autorzy Srodowiska przeznaczyli je od samego poczatku dla inzynierow i
naukowcow, ktorzy wtasnie w ten sposob rozwigzuja problemy. Dlatego
tez uznali, ze wtasnie takie podejscie do programowania bedzie
najbardziej naturalne dla oséb, ktore beda uzywaty LabVIEW.”
Wikipedia
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Prosty program w jezyku tekstowym C++
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Prosty program w jezyku
graficznym LabVIEW
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Zastosowania LabVIEW

Kontrola
jakosci

Sterowanie : typu

,, ///;,,,,//g, / 'Embedded'
// ‘f}m
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Korzystajac z LabVIEW mozna tworzy¢ programy, ktorych zadaniami moga by¢:
zbieranie danych pomiarowych, sterowanie procesami, sterowanie ukladami typu
,Embedded”, monitorowanie proceséw, czy kontrola jakosci. Glownym celem tworzenia

oprogramowania do tych zastosowan, jest czeSciowe lub calkowite zautomatyzowanie
tych czynnosci.



Platformy docelowe LabVIEW

Urzadzenia
modularne

Urzadzenia
mobilne
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Programy tworzone w LabVIEW moga by¢ przeznaczone na urzadzenia klasy PC
(oparte o system MS Windows, Apple OSX oraz Linux), urzadzenia mobilne oraz
urzadzenia typu ,,Embedded” produkowane przez National Instruments. Program moze
wykorzystywa¢ wiele z tych urzadzen, komunikujac si¢ przy pomocy rdznych
interfejsow (np. USB, Ethernet, RS-232, GPIB itp.)
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Zastosowania LabVIEW w LEPS (K63)

MFIA

‘ e 00 O
0.0 0.0 0.0 9 9.
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LabVIEW  znalazto  wiele zastosowan ~w  Laboratorium  Charakteryzacji
Potprzewodnikow Metodami  Elektrycznymi (Katedra Fizyki Doswiadczalnej).
Wykorzystywane jest do sterowania urzadzeniami takimi jak np.: kontroler temperatury
Lake Shore 325, analizator impedancji Zurich Instruments MFIA, czy kamera CCD
Symphony II. Urzadzenia te, odpowiednio oprogramowane, daja dostep do technik
takich jak niestacjonarna spektroskopia pojemnosciowa, czy pomiary widm
fotoluminescencji.
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LabVIEW — okno startowe

Nowy
Program

ABVIEW - o x
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Programy w LabVIEW nosza miano VI (ang. Virtual Instrument), czyli wirtualnych
przyrzadow (pomiarowych, sterujacych itp.). Nowy program mozna stworzy¢ w oknie
startowym klikajac File>New VI (lub CTRL+N). Programy tworzone w LabVIEW
zwykle organizowane s3 w postaci projektoéw. Nowy projekt mozna stworzy¢ w oknie
startowym klikajac File>Create Project.
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Block diagram Front panel

Untitled 3 Front Panel * - O X
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Interfejs uzytkownika: kontrolki,

Funkcje, przewody, subvi, struktury... indykatory, opisy
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Kazdy program w LabVIEW posiada dwie czgsci: Block Diagram oraz Front Panel.
Block Diagram jest miejscem w ktorym definiowane sa wszystkie czynno$ci ktore
zostang wykonane: funkcje, SubVI, struktury, taczace je przewody itp.. Front panel
stanowi swoisty interfejs uzytkownika i stuzy do komunikacji z uzytkownikiem (oraz
innymi programami). Front panel sklada si¢ z kontrolek, indykatorow, opisow,
elementow dekoracyjnych itp.. Skrot CTRL+E umozliwia szybkie przetaczanie migdzy
tymi oknami.
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Tools Palette — paleta funkcji

Untitled 3 Block Diagram * - O X
File Edit Project Operate Tools Window |'-w|—v‘
o
Functions Palette AUto
PoemSs|  Tools Palette
CQuick Drop Ctrl+Space

Breakpoint Manager
Probe Watch Window

Event Inspector Window

[ L Zmiana wartosci / Edycja tekstu

|I VI Hierarchy

m LabVIEW Class Hierarchy
Mo Browse Relationships 3 . / .
Bookmark Manager . .
= ? Laczenie he Przewijanie
przewodow
Class Browser Ctrl+Shift+B

MET Assemblies in Memary

ActiveX Control Property Browser

Getting Started Window...

Navigation Window Ctrl+Shift+N .
Zmiana koloru
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W trakcie tworzenia programu pomocna moze by¢ tzw. paleta funkcji. Mozna ja
wyswietli¢, klikajac View>Tools Palette. Paleta ta zawiera zestaw przyciskow
przelaczajacych miedzy funkcjami kursora myszy.
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Context Help — pomoc kontekstowa

Insert Into Array

n-dim array
index 0

pr

i

PRI
. =
index n-

n or n-1 dim array

output array

Inserts an element or subarray into n-dim array at the
point you specify in index.

Detailed help v

EETER >
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Okno pomocy kontekstowej mozna otworzy¢ klikajgc Help>Show Context Help, Klikajac
okno pytajnika, lub CTRL+H. Po najechaniu kursorem na ikone funkcji, kontrolki,
indykatora itp., wyswietla podstawowe informacje o tych elementach.
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Paleta funkcji i kontrolek
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Klikajac prawym przyciskiem myszy na block diagram (lub front panel), uzyskuje sie
dostep do palety funkcji (lub kontrolek). Palety te zawieraja wszystkie wbudowane w
srodowisko elementy pozwalajagce budowaé programy. Mozliwe jest tekstowe
wyszukiwanie elementow.



Nodes — wezty

Simulate Signal
Sine H
Y

error out
b Amplitude
kerror in (no errol

b Frequency
» Offset
g Phase
P Reset Signal

Write Delimited Spreadsheet.vi
@f

tHEH

konfigurowalne w osobnym
okienku

zalezna od danych
wejsciowych

» PRk Y

Express Vi

Standard Vi
ograniczona konfiguracja,

Proste funkcje
niekonfigurowalne
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Controls — elementy sterujgce
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,Kontrolki” to elementy Front Panelu odpowiedzialne za wprowadzanie danych do

programu. Przyktady kontrolek to m.in.: pokretfa, suwaki, przyciski, przetgczniki. Na

Block Diagramie ikona kontrolki

oznaczona jest charakterystycznym tréjkatem,

sygnalizujgcym kierunek danych wychodzacych z elementu.
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Indicators — wskazniki
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»Indykatory” to elementy Front Panelu odpowiedzialne za wys$wietlanie danych
wyjsciowych programu. Przyktady indykatoréw to m.in.: paski stanu, diody, wykresy,
tekst. Na Block Diagramie ikona indykatora oznaczona jest charakterystycznym
trojkatem, sygnalizujacym kierunek danych wchodzacych do elementu.




State

|%C:\Program Files\Matienal Instruments\LabVIEW 2017 |

28,2828

: Niezmienne w .
Dostarczaja danych trakcie dziatania Niedostepne z Front

wejsciowych Panelu
programu
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Jako zrodto danych wejsciowych w programie wykorzystane moga zosta¢ takze state.
Warto$¢ statych pozostaje niezmienna w trakcie dziatania programu, a uzytkownik nie
ma do nich dostepu z poziomu Front Panelu.




Wires — przewody

Floating-point

Scalar
1-D Array
2-D Array

Przewodd btednie potaczony
oznaczony jest czerwonym X

Integer

String Boolean
- - il -

‘% Politechnika Wroctawska

Do przesylania danych pomig¢dzy roéznymi elementami programu wykorzystuje sie
przewody taczce ich terminale. Przewody przyjmuja rézne kolory i grubosci w
zalezno$ci od typu danych jaki przenosza. W przypadku btednego potaczenia przewodu
(np. potaczenie terminali réznych typdéw), przewdd oznaczany jest czerwonym X. Takie

btednie potaczone przewody mozna szybko usungé skrétem CTRL+H.
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Przeptyw danych

MNurmeric

Numeric 2

Jizsh

Funkcja wykonuje sie
dopiero, gdy dostepne sa
wszystkie dane wejsciowe.

28

Funkcja przekazuje dane
dalej, dopiero po wykonaniu
funkcji.
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Pytanie 1
Ktdéra funkcja wykona sie jako pierwsza?

Murmeric

Wskaz kontrolki, indykatory, state i funkcje.

‘% Politechnika Wroctawska
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Pytanie 1

Wskaz kontrolki, indykatory, state i funkcje.
Ktdéra funkcja wykona sie jako pierwsza?

) Funkcje
Kontrolka — Q
[ oy Dodawanie wykona
- sie jako pierwsze.
State <
Indykator
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Pytanie 2

Ktdéra funkcja wykona sie jako pierwsza?

‘% Politechnika Wroctawska
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Ktdéra funkcja wykona sie jako pierwsza?

Pytanie 2

‘% Politechnika Wroctawska
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Zadanie 1: M9j pierwszy program

Wykorzystujgc funkcje Simulate signal zasymuluj sygnat
sinusoidalny o czestotliwosci 0.8 Hz i amplitudzie 28.
Wykorzystaj Waveform chart do wizualizacji danych. Catos¢
umiesé¢ w petli While podtaczjac przycisk Stop jako warunek
korczacy petle. Wykorzystaj funkcje Wait (100 ms) do
spowolnienia programu.

% Politechnika Wroctawska
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Zadanie 1: M9j pierwszy program

Przyktadowe rozwigzanie:

While Loop
Waveform Chart
Simulate Signal =
Sine EEI
error out
Amplitude
Ferror in (no errol Wait (ms)
b Frequenc
b Offset
Phas
Reset Signal
stop
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Zadanie 2

Zmodyfikuj swoéj program, w taki sposéb aby uzytkownik
mogt zmienia¢ amplitude sinusoidy (w granicach 10-100) oraz
czestotliwos¢ (w granicach 0.1-10 Hz).

Podpowiedz: wykorzystaj odpowiednie kontrolki i ich opcje.

‘Hg Politechnika Wroctawska
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Zadanie 2

Przyktadowe rozwigzanie:

Waveform Chart Sine | |
60-
40 & & u la
v 20+ A
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-V ’
-40 ¥ ¥ ¥
-60-! |
12909516 17.909516
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amplituda Czestotliwosé (Hz)
50 60 102
40 ¢+ TO 7 5_:
30~ 80 i
20- ~90 7 stop
10 100 2 STOP

m_:.
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Zadania

3. Uzywajac Tools Palette zmodyfikuj wyglad Waveform
chart.

4. Stwoérz drugi generator fali sinusoidalnej. Wykorzystaj
funkcje Merge signals oraz Add. Jaka jest réznica?

5. Wykorzystujgc odpowiedni Express Vi oblicz pochodng po
czasie sygnatu sinusoidalnego i przedstaw wyniki na
jednym wykresie.

‘% Politechnika Wroctawska
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Zadanie domowe

Zapoznaj sie z funkcjami, ktore dostepnye sg w palecie funkgji
w kategorii Programming (Structures, Array, Numeric,
Boolean, String, Comparision).

Zwroc¢ uwage na ogolne przeznaczenie tych funkcji oraz na to
w jaki sposdb podzielono je na podkategorie. Skorzystaj
z pomocy kontekstowej dostepnej w Srodowisku LabVIEW
lub z dokumentacji On-Line.

‘% Politechnika Wroctawska
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https://www.ni.com/docs/en-US/bundle/labview-api-ref/page/menus/categories/programming/dir-mnu.html
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